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Lesson objectives

After completing this lesson, you’ll be able to do the following:

 Understand the differences between and be able to create new inventory, 
non-inventory, assembly, group, and service items

 Print inventory lists and price tags

 Explain how Point of Sale tracks item costs and prices

 Describe the different ways of displaying information about inventory items

 List the essential information fields used to add an inventory item

 Use sorting, searching, and filtering to locate specific items or groups of items

 View an item’s history

 Use Style view to work with groups of related items

 Set up multiple vendors for items with unique UPCs and order costs

 List the documents that directly affect inventory values and quantities

Learning resources

The following is a list of additional resources that you might find useful in increasing 
your understanding of the content covered in this lesson.

 Webinar (recorded): Setting up inventory

 Learning Center tutorial: How to enter items and services

 Learning Center tutorial: How to find an item

 Learning Center tutorial: How to adjust the cost or quantity of an item

 Learning Center tutorial: How to tag items

 Learning Center tutorial: Setting up Multiple Units of Measure

 Learning Center tutorial: Using item numbers

 Learning Center tutorial: Using styles for similar items

 Learning Center tutorial: Getting the most out of your inventory

 Learning Center tutorial: How to customize inventory for your business

Working with items

Point of Sale inventory is designed to help retailers define, track, view, edit, and group 
merchandise in a convenient and efficient manner. Each row in the item list represents 
a unique item. Point of Sale can store an unlimited number of inventory items.
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The inventory system is referred to as a perpetual inventory system, because 
transactional documents created in Point of Sale (receiving vouchers, sales receipts, 
adjustment memos, and transfer slips) keep the item quantities and costs updated 
automatically.

Point of Sale inventory stores all item information, including:

 on-hand quantity

 average cost and order cost

 up to five different price levels

 UPC codes (bar codes and numbers issued by the Uniform Code Council to give a 
retail product a unique identifying number)

 tax status assigned to each item

 minimum quantities (reorder point)

 ...and much more.

This lesson explains how to add, view, and work with inventory items and their 
associated information fields.

Note: The method of inventory valuation is average cost. Point of Sale does not track 
inventory on any LIFO or FIFO methods.



                                                                                                

119

L E S S O N  5

Understanding item types

There are several ways Point of Sale can categorize and work with items:

Note: (Pro Multi-Store) Remote stores can only add or edit special order items.

Inventory Items Most items sold are inventory items. These are items 
that a retailer purchases from vendors, sells to 
customers, and tracks on-hand quantities. Inventory 
item quantities and/or costs are updated by 
transactional documents.

Service Items Used for charging for repairs, alterations, warranty 
work, or other non-merchandise charges on 
customer orders and sales receipts. The on-hand 
quantity of service items is always zero, as they are 
non-merchandise items.

Non-inventory Items Non-inventory items are also typically used to sell 
non-merchandise items and their quantity is always 
zero. Non-inventory items offer a way to use 
non-merchandise items and have them posted to 
QuickBooks financial software differently than 
service items. Some retailers choose to use 
non-inventory items for incidental merchandise for 
which they do not wish to track quantities. Some use 
non-inventory items for shipping and handling 
charges.

Assembly Items (Pro) An assembly item is “built” from two or more other 
inventory items. For example, a Christmas Ski 
Package is built from of a pair of skis, bindings, and 
boots, all of which already exist in inventory as 
individual inventory items. Once an assembly is 
built, the specific individual item units included are 
no longer available for individual sale.

Group Items (Pro) A group item provides an efficient way to group and 
sell two or more items, at a defined group price, by 
entering or scanning a single item identifier. Group 
items differ from assemblies in that they are not 
pre-built and the component items remain in 
inventory individually. 

Special Order Items 
(Pro)

Special order items are used to sell custom or 
one-time merchandise that are not currently carried 
in inventory and may never be carried. Special order 
items can only be added to inventory while creating 
a document to order or sell them. If a retailer decides 
later to carry the special order item, it can be easily 
converted to a regular inventory item.
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Defining items

This section covers the basic rules and information fields typical for defining inventory 
items. Detailed instructions on how to create, edit, and delete specific item types are 
covered later in this lesson. 

Using items fields

Although many information fields are available in inventory, the essential fields that 
serve to define each item are:

The Item window contains four tabs that allow you to record detailed information 
about each inventory item: Item Info, Additional Info, Custom, and History.

 Item Info—item type, department, vendor, description, attribute, size, price, cost, 
quantity, item lookup, style, sales tax, and group/assembly

 Additional Info—preferred vendor, UPC, Alternate lookup, order cost, include 
when printing tags, unorderable, multiple vendors (Pro), commission (Pro), and 
serial number (Pro)

 Custom (Pro)—custom item fields

Item Type What type of item is this? 
Required.

Department The department to which the item is 
assigned.
Required. 

Vendor The vendor from whom this item was 
acquired.

Description 1 The principal description of the item, 
making it easy to identify. Printed on sales 
receipts and other documents.
Required.

Attribute A field used to describe an item 
characteristic, typically color, material, 
pattern, a second size, etc.

Size The size or any other characteristic of an 
item (the field is labeled Size, but is 
essentially another Attribute field).
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 History—item history

The History tab is discussed in “Viewing an item’s history” on page 129.

Each item must be unique in these fields (i.e., there cannot be multiple items in 
inventory with the same combination of Department, Description 1, Attribute, and 
Size). It is not sufficient to record some unique data in Vendor or Description 2 or in 
some other item field.

Every item (except special order items) has an Item # assigned by Point of Sale when 
added to inventory. This Item # can be edited but cannot be deleted. Item numbers must 
be unique, duplicates are not allowed.

Besides being used for item lookups from documents, item numbers are also used to 
print bar code tags from within Point of Sale. This allows you to lookup and list any item 
in your inventory using a bar code scanner.

Do not enter the item number in any other item field to print bar-coded tags.

Note: Technically, only an Item Type, Department, and Description are required to 
define and save a new item. However, we strongly suggest that, at a minimum, 
you also enter a Vendor and at least one Attribute or Size. If you do not, you may 
end up with conflicting items and this will result in serious problems in working 
in Style View (Pro) and in properly tracking and reporting item movement.

Customizing field labels

The four item descriptive fields (Description 1, Description 2, Attribute and Size) can be 
re-named to better suit the merchandise clients sell. Throughout this lesson, we use the 
default names when talking about these fields.
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To customize item field labels:
1 From the Edit menu, select Company Preferences.

2 Click My Field Labels in the list of preferences.

3 Edit the field names as desired.

4 Select the Use checkbox to use the field.

5 Click Save.

Adding custom fields to an item

Pro-level users have the ability to define five custom fields for inventory items. These 
fields can be used to record other item information important to clients’ businesses. For 
example, you might use a custom field to record vendor-required identifiers that aren’t 
suited for other Point of Sale item fields. 

Once defined, custom fields can be added to the item list and used for filtering and 
reporting purposes. Using Print Designer, custom fields can be added to printed 
documents and tags.

To add a custom item field:
1 Click the Custom tab in the New or Edit Item window.

2 Click Define Fields in the Custom Fields section.

3 Enter the names of the desired custom fields.

4 Select the checkbox next to the custom field to activate it.

5 Click OK.

Entering item quantities and costs

You may define initial on-hand quantities, reorder quantities, costs, prices, and 
margin/markup when defining a new item. However, use caution in entering on-hand 
quantities and costs for new items.

 An item's quantity is increased by the quantity received when a receiving voucher 
is made. If you manually enter the quantity of a new item you are going to be 
receiving on a voucher, the voucher will also add the received quantity, thus 
doubling the inventory on-hand quantity. It is generally recommended that you 
manually enter a quantity only when adding existing items during program 
startup.

 Receiving vouchers also automatically update the average item cost (Cost field) and 
order cost (Order Cost field) as items are received into inventory. Allowing the 
voucher to enter this information for new items is the best way to ensure accurate 
cost values and inventory valuation.
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Affecting item quantities and costs in QuickBooks 
financial software

Adjustment memos are automatically created when quantities or costs are manually 
entered or edited. The memos are sent to QuickBooks financial software where they 
affect inventory valuation.

Data imported from QuickBooks financial software, including existing item 
descriptions, quantities, costs, and prices, are automatically entered into Point of Sale. 
However, these and other fields, such as departments and vendors, should be reviewed 
and edited to fit the needs of the business.

Inventory items are never exchanged between the two programs after the initial import. 
It is strongly suggested that you create, edit, order, and sell items only in Point of Sale or 
only in QuickBooks financial software, but not in both.

Viewing the Item list

Items are displayed in list view as shown below. All normal list procedures, such as 
filters, sort, and search work in the item list.

To access the Item list:
 From the Inventory menu, select Item List.

Each item is listed on a separate line. To display only items that meet specified criteria, 
make a selection from the filter drop-down list at the top of the Item list. Choose a 
predefined filter, such as “All Items,” or create and save your own custom filters.

Viewing an item in Form view

Form view is used to take a detailed look at a single item, to add a new item, and to edit 
an item.
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To switch to Form view:
 With the Item list displayed, double-click an item in the list. 

The tabs on this page vary, depending on the level of Point of Sale that you use.

(Pro) If you work with groups of related items as styles, you may find it is much more 
efficient to use Style view when creating a new style or adding items to an existing style. 
(Refer to “Working with item styles (Pro)” on page 141 for more information.)

Managing inventory items

This section describes the tasks available to manage inventory items, including adding, 
locating, editing, and deleting.

Adding a new inventory item

To add a new inventory item:
1 Select New Item from the Inventory menu.

A blank item record is opened in Form View. 

2 Select an Item Type.

The default item type is inventory.

3 Enter a Department, Vendor Name, Description 1, Size, and Attribute.

4 Enter data in other item fields:

 We recommend that you enter an on-hand quantity and cost only if you are 
adding items already in stock in a new Point of Sale setup. If this is a new item 
being ordered on a PO, leave On-Hand Qty and Average Unit Cost fields at zero 
or blank. These fields are updated when the item is recorded on a receiving 
voucher.

 If you prefer to manually define item prices, enter a Regular Sales Price. The 
prices at the markdown price levels, if used, are automatically calculated based 
on the price level preferences. 

 If you prefer to have Point of Sale calculate prices, using the default margin or 
markup recorded in the department record, leave the price fields blank. When 
the item is received on a voucher, Point of Sale populates the cost field and 
calculates the prices at all levels. 

 Specify a Tax Code, if applicable.

 Scan or type the UPC or Alternate Lookup values.

 Enter an Order Cost and optionally, an MSRP reference price.

5 Click Save.

(Pro) If the new item matches an existing style definition, you are prompted to join the 
item to the existing style. (See “Working with item styles (Pro)” on page 141 for more 
information.)
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Copying an inventory item

Sometimes the quickest way to add a new item to inventory is to copy an existing similar 
item and then edit to make it unique.

1 Highlight or display the item you want to copy.

2 Click Copy Item on the window icon bar.

The information from the existing record is pasted into a new item record. 

The following fields are not copied: On-Hand Qty, UPC, Alternate Lookup, and 
Unorderable flag. 

3 Enter new values in the fields as appropriate, as well as editing any other fields that 
differ from the copied item. 

At least one of these fields must be edited to avoid creating a duplicate item: 
Department, Description 1, Attribute, or Size.

4 Click Save.

Locating an item

Locate items in the item list by filtering, searching, sorting, or scrolling in the list. If 
you’re not sure how to perform these actions, refer to the User’s Guide. 

Editing an item

Use care when editing items, especially the on-hand quantity or average unit cost of an 
item. These values are important for tracking inventory value and generally you should 
let Point of Sale documents update these values. If you do manually edit them, Point of 
Sale creates adjustment memos and sends them to QuickBooks to update inventory 
value.

To edit an item:
1 Highlight an item in the Item list.

2 Click Edit Item.

3 Navigate through the fields, making necessary edits. 

4 Click Save.

If you want to edit several items at once, it may be easier to do so in list edit mode. List 
edit mode allows you to make edits directly in the item list. Your edits are saved as you 
move from row to row. 

To turn list edit mode on, select Turn List Edit Mode On from the Edit menu. When 
finished, select Turn List Edit Off from the Edit Menu. Leaving the item list also turns off 
list edit mode.
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Deleting an item

Delete items with caution to avoid accidentally deleting items with a non-zero quantity 
or those that are listed on open order documents.

To delete an item:
1 Highlight or display the item.

2 From the I Want To menu, select Delete Item(s).

A warning displays if the item you are deleting has a non-zero on-hand quantity or 
is listed on an active order document.

3 Click Delete to delete the item or Cancel if you do not want to delete the item. 

If the item still has an on-hand quantity, a quantity adjustment memo is created to 
send to QuickBooks financial software. In the memo Reason dialog, enter your 
name and a reason for the deletion. 

Note: If you delete an item, but then create or reverse a transactional document that 
lists that item, Point of Sale adds the item back to inventory. This ensures that 
the document posts correctly and that inventory reflects any change effected by 
the document. 
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Assigning item tax codes

By default, all new items added to inventory are assigned the tax code specified in the 
associated department record. Change the tax code for individual items in inventory as 
needed when adding or editing an item.

For more information on setting up sales tax, refer to “Collecting sales tax” on page 259.

To assign tax codes to items in inventory:
1 Open the New or Edit Item window.

2 Click the Item Info tab.

3 In the Price & Cost section, select the appropriate tax code from the Tax Code 
drop-down list.

4 Click Save.

Note: To quickly change the tax code for all items in a style, edit the Tax Code field in 
the upper pane of Style view. When you click Save, the tax code is saved for all 
members of the style at once. (See “Working with item styles (Pro)” on page 141 
for more information.)

Using item reorder points

You can define a reorder quantity (using the Reorder Point field) for each inventory 
item, which populates the Reorder Reminders window with items that have fallen to or 
below their specified reorder quantity. Point of Sale takes into consideration any 
quantities already on order before adding an item to the Reorder Reminders list. 

Reviewing the reorder reminders list assists in the task of making replenishment 
purchase orders. The reorder items can also be viewed by running a Reorder Point report 
under the Items report type in the Report Center. For more information about running 
reports, refer to Lesson 10, “Reporting and customizing.”

Note: Zero (0) is a valid reorder point. New items default to a null (no entry) reorder 
point value.

(Pro) For assembly items, a reorder point indicates that quantity at which you want to 
build more of the assembly item. Similar to a Reorder Point report, a Build Point report 
lists the assembly items that have fallen below the specified level. 

(Pro Multi-Store) Reorder points are based on quantities for the company as a whole, not 
on individual store quantities.
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Flagging an item as unorderable

When an item is marked as unorderable (the Unorderable checkbox is selected on the 
Additional Info tab), its reorder point is ignored and a warning appears if the item is 
listed on a purchase order. This field is helpful in temporarily suspending purchasing of 
seasonal items or for flagging an item that has been discontinued by the client or a 
vendor. Items marked as unorderable may be received, sold, transferred, etc.

Using units of measure

The units of measure field is used to indicate the measurement or quantity by which the 
item is sold, such as each, inch, yard, gallon, case, gross, etc. Units of measure are 
defined in Company preferences. Once defined and added to item records, units of 
measure can be used to filter the Item list or reports.

To assign a unit of measure to an item:
1 Open the New Item or Edit Item window.

2 Click the Item Info tab.

3 In the Quantity section, select the appropriate unit of measure from the Unit of 
Measure drop-down list.

4 Click Save.

(Pro) Units of measure can be added to printed documents and tags using the Print 
Designer.

Tracking multiple units of measure

The use of multiple units of measure allows the purchase and sale of an item in up to 
four different units (sizes, or pack quantities).

For example, the retailer might buy a canned item by the case but sell it by both the case 
and individual can. QuickBooks POS allows you to define a separate UPC, alternate 
lookup, sales price, and default purchase-by and sell-by units in inventory, and then 
automatically suggests the correct unit on documents.

Turn on the multiple unit of measure feature and add the various units you are likely to 
use on the Inventory page of Company preferences.

See the in-product Help for more information about applying multiple units of measure 
to inventory.

Using decimal quantities

Sometimes it is beneficial to track items in decimal quantities. For example, a retailer 
might sell an item by the yard (e.g. fabric) or by weight (e.g. bulk candy). Point of Sale 
allows you to order, track, and sell these items in decimal units.
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For example, if you order and price fabric by the yard, you can easily sell 1/4 yard or 
1-1/2 yards by entering .25 or 1.5 in the Qty field on receipts. Trailing zeroes are not 
displayed when a decimal quantity is entered in inventory (or on a document).

If a client uses service items, such as hourly fees for labor, quantity decimals are helpful 
in charging for partial hours worked. In inventory, create a service item called Labor and 
assign the hourly rate as the price. Then, on a receipt or customer order, list the service 
item Labor and charge for partial hours by entering a decimal quantity in the Qty field.

Viewing an item’s history

Item history allows you to view summarized statistical data for items in inventory, as 
well as displaying all documents that have affected the item quantity. The summarized 
data shows the changes of the item quantity from all transactions that affect inventory.

(Pro Multi-Store) Item History is available only at Headquarters. Use the Store 
drop-down list at the top of the window to display documents for any one store or for 
the entire company.

To access item history from the item list:
1 Highlight an item record in the list.
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2 Click Collapse to access the Item Information Panel which displays the item 
history.

OR

View the item record in Form view and click the History tab.

To view a listed document:
1 Highlight the document in the History list.

2 Select Go to Document from the I Want To menu.

OR

Use QuickZoom to display the document, if available.

Working with item history

The Qty Change column lists the effect of a document on the item’s on-hand quantities. 
For example, a sale results in the on-hand quantity being reduced, therefore the Qty 
Change is a negative number. Likewise, receiving a quantity into inventory is shown as 
a positive number.

If the item is listed multiple times on a document, such as a customer exchange for the 
same item, the document is listed twice; once for the return (as a positive quantity) and 
once for the new sale (as a negative quantity.) The New Qty column displays a running 
total of the on-hand quantity, after being adjusted by the document.

Print the entire history of an item by selecting Print History from the I Want To menu.
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Using multiple vendors for an item (Pro)

Point of Sale allows clients to track up to five separate vendors for any inventory item, 
each with a unique UPC, Alternate Lookup, and order cost. This allows them to 
purchase the same item from any of several vendors as availability and costs change. 

For information on adding more than one vendor to an item, refer to Lesson 4, 
“Working with departments and vendors.”

Using item ratings and trends

You can easily see the trends for your inventory items, and whether it is increasing or 
decreasing, right from your inventory list.

 Ratings use a star system where five stars is the best possible. (Question marks are 
displayed when no data is available for calculation.)

 The trends will be up or down, as indicated by arrows. A double arrow indicates up 
or down by more than 50%.

Calculations to determine ratings and trends are based upon settings in Company 
preferences. Each rating star is based on 20% increments between the highest and 
lowest values for the category being rated.

For example, if the rating is based upon sales quantity: if the highest amount sold for 
any item is 100, and the lowest sold is 1, any item sold between 81 and 100 quantity in 
the designated time period would receive a rating of five stars. Items with zero sold 
would receive no stars. Select or mouse-over any trend or rating field for details 
explaining the trend or rating for that record.

To set preferences for ratings and trends:
1 From the Edit menu on the Server workstation, select Preferences, then choose 

Company.

2 Select Ratings & Trends from the list on the left.

3 Select the checkbox to turn on Ratings & Trends.

4 Select what you wish the calculation to be based upon, and for what time period.

5 Click Save.
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Note: The maximum time period Point of Sale examines for Ratings and Trends is 999 
days. However, for a trend, the system must be able to compare two time 
periods. The maximum workable time period for trends is 499 days, which 
allows another 499 days by which to compare.

The following apply to ratings and trends:

 Group items are never ranked; but the group component items are ranked 
individually.

 The ranking period can be set from 1 to 999 days. If you choose a 999 day current 
ranking period, trends will not apply as sales data is not read for the previous 999 
days.

 Rankings are updated at least once a day (on program startup or automatically 
between 1 am and 5 am if your computer is running). Rankings are not updated for 
the current day’s sales as they are made.

 Rankings are calculated at Headquarters only and reflect sales at all stores. They are 
sent to remote stores where they can be viewed.

 The ability to view item rankings can be controlled by a security right.

You may need to arrange the columns when viewing the list to position the rating and 
trends columns where they can be easily seen. See “Understanding list display and 
navigation” on page 27 for more information on rearranging columns.

Handling item cost and prices

Each item has two cost fields maintained in inventory. The Average Unit Cost field 
displays the averaged cost of the on-hand quantity of the item. The Order Cost field 
displays the current cost of the item from your vendor, and is suggested when you make 
a new purchase order. Both fields are updated when a receiving voucher with a new cost 
is created.

Over time, it is normal for the Order Cost to be a higher value than the averaged cost, as 
at any point in time there are probably some on-hand units that were received at a lower 
cost than the current order cost.

You can view these fields in the item record list or form. The Order Cost field is located 
in the vendor area on the Additional Info tab of the item form.
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Entering and editing cost values

We recommend that you manually enter a value in the Average Unit Cost field only 
when adding already in-stock items to inventory during program startup. If a new item 
is going to be ordered on a purchase order and received on a voucher, leave the cost field 
at zero (0) and allow the receiving voucher to populate this field.

If you manually edit the average cost, Point of Sale creates an adjustment memo and 
sends it to QuickBooks.

You can enter or edit the Order Cost of an item at any time, but new costs are typically 
entered on a purchase order. The new order cost is then carried to a receiving voucher 
that reference the PO. When the voucher is updated, so is the Order Cost field in 
inventory.

How QuickBooks POS calculates average item cost

An item's inventory cost is always averaged when a receiving voucher is made to receive 
more of the item. The program proportionally averages the old cost and the new cost 
based on existing and received quantities to update the inventory cost.

(On-Hand Quantity x Current Cost) + (Received Quantity x Purchase Cost)
(On-Hand Quantity + Received Quantity)

For example, if you have five units of an item on hand with a cost of $10 each and a 
voucher is made to receive ten new units into inventory costing $12 each, the new 
averaged inventory cost is calculated as follows:

(5 x 10) + (10 x 12) 
(5 + 10)

170
15

A new average unit cost of $11.33.

Note: During the next financial exchange with QuickBooks financial software, the 
receiving voucher updates the QuickBooks financial software inventory value 
for the received items at the voucher cost. The averaging of costs in inventory 
has no additional net effect on inventory value. 

Defining item price levels

Up to five separate price levels can be defined for inventory prices. Price levels are a way 
to offer different prices for different purposes. Typically, Regular Sales Price is used for 
the everyday retail price. The prices at the optional markdown price levels are 
markdowns from the Regular Sales Price. 
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A typical price level setup on an item record might look like the following:

The price level markdowns are applied and the price at each level recalculated anytime 
the regular sales price is changed, either manually or when Point of Sale applies its 
pricing formula. On the other hand, editing the price or markdown percentage of any 
of the markdown price levels has no affect on any other price.

Note: Changing the regular price in Price Manager doesn’t adjust price levels. Refer to 
“Using price manager” on page 190 for more information.

To automatically use a markdown price level for sales to a customer, associate the price 
level with the customer on his or her Point of Sale customer record. See “Using price 
manager” on page 190 for more information.

Editing price levels

Point of Sale suggests the default price level markdowns specified in Company 
preferences for all new items. The Regular Sales Price is applied to all sales, unless it is 
changed on an individual receipt or if the customer has a different price level assigned 
on his record. (For more detailed information on Company preferences, refer to 
Lesson 3, “Installing and setting up.”)

You can edit the markdown percentage or price at any price level on an individual item 
record. Doing so does not affect the price or markdown percentages at other levels for 
the item and does not change the price level default markdowns. Change the price level 
names and the discount percentages as required to fit your client’s needs.
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To edit default price levels from an item record:
1 Display the Pricing window from an item record.

2 Click Edit Price Levels.

The Price Levels window is displayed.

3 Edit the price levels as desired.

4 Click OK.

Note: It is important to note that making changes here has the same effect as if you are 
making them in Company preferences. The changes affect the default price 
levels on all items, not just the item you are currently viewing.

Any action that changes the regular sales price causes the prices at each markdown price 
level to be recalculated, including:

 Manually editing the regular sales price or editing the margin/markup (which 
causes a change in the regular sales price)

 The Point of Sale pricing formula, when it is applied to new items

(Pro Multi-Store) Remote stores cannot define price levels, but they can set the default 
price to use for sales at their store.

Using a price level for a sales event

If you defined a price level to use for a sales event, such as a weekend “10% Off Sale,” 
change the default price in Company preferences to the 10% markdown level for the 
weekend. All sales made for the weekend automatically mark down prices by 10%. 

The price used on a sale is called the “active” price, and any additional item discounts 
given at time of sale are applied against the active price.

Remember that prices need to be set back to their defaults before the store’s opening on 
Monday. 
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Note: Price Change Reminders display the old and new prices for whatever price was 
selected as the default price. If you change the default price, the Price Change 
Reminders list is cleared since it reflects old and new prices at the previous 
default prices. Refer to “Setting inventory reminders” on page 138 for more 
information about price change reminders.

Using service and non-inventory items

Both service and non-inventory items are used to charge for non-merchandise services, 
labor, and miscellaneous fees and charges. The on-hand quantity of both item types is 
always zero (0).

To create a service or non-inventory item, select the appropriate item type when adding 
the item in inventory. The items can then be listed on purchase orders, receipts, and 
customer orders (Pro) as needed, and broken out in sales reports.

Having two non-merchandise item types allows clients to categorize and report the 
various uses to different accounts in QuickBooks. For example, you want to send repair 
work to one QuickBooks account, and time-of-sale charges, such as tailoring, gift-
wrapping, and delivery to a different account. You can define item accounts for each 
item type or for individual items. For more information, refer to Lesson 12, “Exchanging 
data.”

Some clients may choose to use non-inventory items for incidental merchandise when 
they do not wish to track on-hand quantities. For example, a client keeps a basket of 
mixed low-cost trinkets near the register. He or she sees by sight when to reorder and the 
impact on financials is incidental. Define a single non-inventory item to sell any of the 
included items, which vary depending on vendor over-runs, closeouts, etc.

Using service items to charge for services by the hour

Use a service or non-inventory item to charge for services by the hour (or half-hour, 
quarter-hour, etc.). Define the item, selecting either service or non-inventory as the 
item type. The price for the item should be the price to be charged per unit of time (hour, 
half-hour, quarter-hour, etc.).

When the item is listed on a receipt or customer order, enter the units of time to be 
charged in the quantity field. For example, if you are charging by the hour, enter 1.5 as 
the Qty to charge for an hour and a half.
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Printing the item list

To print the item list:
1 Display the item list and select those records to include in the printout:

 If printing all items, you do not need to make an item selection. Make sure the 
list filter is set to display All Items.

 If printing a subset of the list, filter the list first or select those items to be 
printed.

 See “Understanding list display and navigation” on page 27 for instructions on 
selecting multiple records.

2 Select Print Items from the Print menu on the window icon bar.

3 In the Print Items dialog, select:

 Print all items – to include all items currently displayed in the list

 Print selected items – to include only the items selected

A preview of the item list is displayed.

4 Click Print.

Printing inventory tags

You can print tags on the tag printer supplied as a hardware item or on an office printer 
that prints on 8½” x 11” sheets.

While it may be cheaper to use a standard printer, there are a couple of reasons to 
consider a tag printer:



138

S e t t i n g  u p  i n v e n t o r y

 If you print just a few tags at a time, a tag printer is usually beneficial.

Using a few labels on an 8½” x 11” sheet means that the sheet may go through the 
printer multiple times and the tags may change color from repeated exposure to the 
toner.

 The tag printer does an excellent job of printing the “barbell” type tags frequently 
used by jewelry stores.

To print tags:
1 Highlight or display the item for which you want to print tags. 

If you want to print tags for a group of items, use a filter to display just those items 
or select the items you want to print. 

2 Select Print Tags from the Print menu on the window icon bar.

3 To change the tag template, click More Options to display the print options.

4 Select the tag to print from the Item Template drop-down list.

5 Click Preview Template to view the tag template and select a different template, if 
desired.

6 Click Print.

For additional information about printing inventory tags, refer to Lesson 6, 
“Maintaining inventory.”

Setting inventory reminders

The Inventory Reminders feature helps clients track and manage inventory by alerting 
them to situations that may need their attention, such as when item quantities fall 
below their reorder points or merchandise needs to be retagged due to price changes.

The types of Reminders available vary depending on the level of Point of Sale used and, 
in a multi-store configuration, whether the store is a Headquarters or remote store.
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The types of Reminders available at each level are:

 All Levels—Item quantities at or below their reorder points

 Pro Levels—Item price changes, new items added to inventory, fill customer orders

 Pro Multi-Store—Duplicate items added to inventory

For users of Pro Multi-Store, reminders are a convenient way to communicate price 
changes and new items to remote stores. (For more information about the Reminders 
features that are unique to a multi-store configuration, refer to Lesson 11, “Working 
with multiple stores.”)

To be alerted when Reminders are available to view:

Point of Sale allows a Reminders icon to be added to the QuickBooks POS status bar at 
each workstation. With this option turned on, a brief Reminders message is displayed 
upon program startup if reminder items are pending for review. Clicking the icon or 
message link opens the Reminders window.

To manually access the Reminders window:
1 Select Reminders from the Inventory menu.

2 Select one of the reminder tabs available to display the affected items:

 Reorder items

 New items

 Price changes

 Fill customer orders

 Duplicate items (Pro Multi-Store) 

To print the displayed Reminders list:
1 Select Print Item(s) from the Print menu on the window icon bar.

2 In the Print Reminders window, select the All Displayed option.

3 Click Print.
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Reorder Items Reminder

The Reorder Items tab displays all items whose combined on-hand quantity and 
on-order quantity has fallen to or below their reorder point as set in inventory. This 
screen can help clients identify those items that need to be ordered from vendors.

As an option for Pro users, QuickBooks POS suggests and generates purchase orders to 
order these items. This feature is discussed in greater detail in Lesson 6, “Maintaining 
inventory.”

To have Point of Sale suggest purchase orders (Pro):
 From the I Want To menu, select Suggest PO.

New Items Reminder (Pro)

The New Items tab displays new items added to inventory. This screen alerts users to 
prepare the store for the arrival of these items. Monitoring this list also allows associates 
to better serve customers by letting them know what new merchandise is coming soon.

The items on this list should be removed as they arrive at the store so that the list 
remains current and useful.

To select items to print or remove:
 Select a single item, or you can also use the multi-select feature to select a number of 

specific items by holding down the Ctrl key and selecting the items. 

 Choose Select All to select all items on the list

 Choose Select None to clear (uncheck) all previously selected items

 Select Remove Selected Item(s) to delete the selected items from the list

 Select Print Items or Print Tags from the Print menu to print the selected items

Price changes reminder (Pro)

The Price Changes tab displays item price changes. Both the Old Price and New Price at 
the default price level are displayed in the list. This option reminds the user to update 
the price tags, so the inventory records and the tagged items on the shelf match. 

After reviewing these items and printing tags, the user should remove the items on this 
list so that the list remains current and useful. 

To select items to print or remove:
 Select a single item, or you can also use the multi-select feature to select a number of 

specific items by holding down the Ctrl key and selecting the items.

 Choose Select All to select all items on the list

 Choose Select None to clear (uncheck) all selected items

 Select Remove Selected Item(s) to delete the selected items from the list

 Select Print Tags to print price tags for the selected items



                                                                                                

141

L E S S O N  5

Fill customer orders reminder (Pro)

The Fill Customer Orders Reminder screen displays open customer orders that can be 
filled or partially filled with the available (including just received) item quantities. 
When backorder items are received on a receiving voucher, Point of Sale alerts you that 
there are customer orders pending for the received items.

Use this screen to review the open orders, select those to fill, and then either go to the 
order or print fulfillment reports and pick lists.

To select orders for print options:
 Choose individual items by selecting the corresponding check-box to the left of the 

item

 Choose Auto-select Orders from the I Want To menu to select all orders on the list 
which can be filled, based upon a date priority of filling oldest orders first

 Select Clear All Orders from the I Want To menu to clear (uncheck) all previously 
selected orders

Select Print Fill Order Report or Print Item Pick List from the Print menu to print these 
reports.

Working with item styles (Pro)

An item style is a means of grouping inventory items that share basic information but 
differ in one or two item traits, such as size, color, pattern, etc. For example, a line of 
running shoes might be carried in ten sizes and two colors. The 20 different size/color 
combinations of this shoe line constitutes a style. 

Defining styles

From a QuickBooks POS standpoint, a style is defined as a group of items that all have 
the same Department and Description 1 entries on their item records. Items within a 
style can have a different Size, Attribute, Description 2, Alternate Lookup, UPC, price, 
cost, etc. Data can be summarized by style on reports, and many program actions can be 
conveniently applied to all the members of a style at once.

Point of Sale provides a way to view and work with all of the items in a style in a single 
window, called a style grid. In a style grid, you can immediately see the on-hand 
quantities of each size, each color, and the total for the entire style, as well as being able 
to use the grid to quickly add items to inventory or to enter order quantities when 
creating a purchase order or receiving voucher.
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The use of styles is optional and not all business types benefit from their use.

If a client prefers to not work with styles, this feature can be turned off in Company 
preferences, which removes the Style view option. For more information on turning off 
Point of Sale features, refer to Lesson 3, “Installing and setting up.”

Note: If you use styles and add more than one item with the same Dept Name and 
Description 1, a style grid is automatically created for the items. If you add a new 
item with the same department and Description 1 as an existing item in 
inventory, the program gives you the option to join the new item to the existing 
style.

Understanding style grid basics

Two of the Point of Sale item descriptive fields (Size and Attribute) make up the two axes 
of a style grid. If you have renamed these fields, your custom names are displayed. (Refer 
to the User’s Guide for more information about renaming item descriptive fields.)

The point where a row and column intersect is called a cell. Each cell is a unique 
size/attribute combination that corresponds to one item or row in the Item list.

This sample style grid shows the size/attribute combinations for a style of hats. The grid 
is formed by listing the available sizes along the horizontal axis and the colors along the 
vertical axis.

Even a relatively small grid like the sample above contains a great deal of information. 
This example shows 15 possible size/color combinations (i.e., 15 items) in the style and 
the current on-hand quantity of each. The style has three colors and five sizes. The store 
does not carry black or grey in size XSML, so those cells ares blank. The store does carry 
tan in size XSML, but it is currently out of stock, so it is displayed with a quantity of zero. 

The bottom and right-hand side of the grid displays totals for each column (size), each 
row (color), and for all style items. You can turn on/off the display of totals values by 
right-clicking in a row or column header and selecting the show totals option.

The number of items that can be included in a style is virtually unlimited. You may have 
to use the vertical and horizontal scroll bars to view all of the style items in the grid.
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The values displayed in the style grid are the on-hand quantities of each item. A blank 
cell means that particular size/attribute for the style has not been defined as an 
inventory item. 

When accessing inventory using “Select from Item List” from a purchase order or other 
document, the style grid cells are initially blank and are used to enter the quantity to be 
transferred to the document (i.e., the document quantity being sold, ordered, received, 
etc.).

(Pro Multi-Store) The Quantities for Store: field at the top of the style grid allows you to 
view quantities for the entire company or for any specific store by making a selection 
from the drop-down list. 

Viewing the style window

The Style window displays a merchandise style in a split-screen view, with the top pane 
showing general information for the style as a whole, and the bottom pane displaying 
all items/quantities in the style in a grid format. Each cell of the style grid represents a 
style item with a unique size/color (or other attribute) combination.

To view the style window:
1 Open the item in Form view.

2 Click Edit/Add Style. 

The Style window displays.

This example is a Style window for an item style comprised of adult baseball hats that 
vary in color and size.

Note: Edits made in the upper pane of this window affect all style items. Make edits in 
this pane carefully.
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The Item list also displays style items, where each item is a separate inventory row and 
has its own item number. 

Members of the same style may be scattered throughout the item list because new items 
can be added to a style at any time.

To sort a style in the item list:
1 From the View menu, select Sort List, then choose Sort on Multiple Columns.

2 Choose Description 1 for the first sorted column.

3 Choose Dept Name for the second sorted column.

You can also filter by these fields to group all items of a particular style together.

Managing styles

The information in this section describes the tasks available for managing styles, 
including adding, editing, and deleting.

Adding a new style

When choosing style descriptions, keep them simple. This makes data entry faster and 
makes it easier to locate the style items later.

To add a new style:
1 From the Item list, select Edit/Add Style from the I Want To menu.

2 Click New Style. 

A new, blank Style window displays. 
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3 In the upper pane, make entries in the required Dept Name and Description 1 fields. 

These essential fields define the style.

4 Enter information or make selections in the other available fields, such as 
Description 2, cost, Price, Tax Code, etc. for which you want to record data for this 
style.

Information entered in the upper pane is applied to all style items. If the items in the 
style will have different prices, for example, leave the price fields blank and edit 
them later for each item individually, or enter the most common price and then edit 
only the ones that differ later.

5 Use the Click to Add fields in the row/column headings to enter the sizes and 
attributes for the style items.

To use a style template, click the down arrow in the Select a Style Template list and 
choose a pre-defined template. Choose Add New to create, save, and apply a new 
template. Refer to “Using style templates” on page 148 for more information about 
using templates.

6 Enter 0 (zero) in each attribute/size cell corresponding to the items in your style.

This creates a new row in inventory for those items. Leave the cell blank if you won’t 
carry a particular attribute/size combination. (If the items are already physically in 
the store and not being received on a voucher, you can enter the actual on-hand 
quantities instead of zeroes.)

7 Click Save.

If you need to edit information fields for individual style items, such as for cost or price, 
use normal item editing procedures (see “Editing an item” on page 125).
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Editing styles 

Edit existing styles to add/delete items, rearrange the order in the style grid, or make 
general edits to pricing and other information fields.

To edit an existing style:
1 Display the style in the Style window.

2 Make necessary edits in the top pane. 

The values displayed are those of the specific item that was selected when the Style 
window was opened. Changing the values in the displayed fields changes that value 
for all members of the style. 

Be careful making changes here. For example, if you have different prices within the 
style, do not change the prices shown in the upper pane or you may inadvertently 
change the prices of other style items.

3 To edit item sizes/attributes, click a column or row header in the grid and type a new 
entry. 

 Note that editing a size/attribute definition in the grid changes the definition for 
all items in that column or row. Select change size/attribute label in the 
confirmation dialog displayed to proceed.

4 To add a new size or attribute, select Click to Add and type the new entry. 

Type 0 (zero) in the new cells created to add the item to inventory.

5 To delete, move, rearrange rows or columns, or to save the grid as a new template, 
right-click on a column or row header and choose the appropriate action from the 
pop-up menu.

 Auto-arrange orders columns/rows numerically or alphabetically

 Auto-adjust adjusts all column widths to the width of the longest entry

6 To edit the on-hand quantity of a style item, click in a cell and type the new value.

Just as on an item form, manually editing a quantity results in Point of Sale creating 
an adjustment memo. The adjustment is sent to QuickBooks to update your 
inventory value.

7 Click Save.
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Updating a style or item

You can also edit style items individually in a regular item form. If you edit the Dept 
Name or Description 1 for an item that is part of a style, Point of Sale asks if you want to 
have that edit to affect the entire style. Click Yes to update the entire style or No to 
update only the item.

Note: If you update only the item, then that item is no longer part of the style.

Deleting a style item 

Carry out this process with caution so that items with on-hand quantities or items listed 
on active documents are not accidentally deleted.

To delete a style item:
1 Display the style in Style view.

2 Highlight an item in the style grid.

3 Click Delete and select Delete Selected Style Item from the pop-up menu.

A warning is displayed if the item still has a quantity on hand or is listed on an open 
order.

4 Click Delete to finish.

OR

Click Cancel to exit without deleting the style item.

If there were quantities on hand for the item, Point of Sale creates an adjustment 
memo to update the inventory value.

Deleting an entire style

Use caution when deleting an entire style so that items with on-hand quantities or that 
are listed on active documents are not accidentally deleted.

This process deletes all items in the style from inventory.

You cannot delete a style if style items are included in an assembly or group item, or if 
they are included in a defined discount price until they are removed.

To delete an entire style:
1 Display the style in the Style window.

2 Click Delete and select Delete Entire Style from the pop-up menu.

3 Click Delete to finish.

OR

Click Cancel to exit without deleting the style.
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Using style templates

A style template is a user-defined array of item attributes (sizes, colors, patterns, etc.) that 
is used to create style grids. Each template can be used for an unlimited number of styles. 
If you prefer, you can create each style grid from scratch in inventory. However, using 
templates makes the process much faster since all the predefined sizes and attributes are 
written on the new grid for you.

For example, many retailers carry lines of merchandise that is very similar in terms of 
the sizes, colors, or other attributes. For example, a shoe store might carry 20 different 
shoe lines, but all tend to have the same or similar size and color combinations. Having 
to re-enter the sizes and colors for every shoe you carry would quickly become tedious.

During the Setup Interview, you may have elected to install default style templates 
typical for your business type. If so, you can apply one of the pre-defined templates to 
styles as you add them. You can also create new templates or edit your existing 
templates.

If a template contains any sizes or attributes that you do not need for a particular style, 
you do not have to define items for those cells. An inventory row is assigned only to 
those cells where you enter a quantity.

Creating a style template

To create a style template:
1 From the Style window, select Add New from the Select a Style Template drop-down 

list.

The Select a Style Template dialog is displayed, with a new template, named New 
Template, opened.
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2 Type a unique name to overwrite the default name.

3 Use the Click to Add fields to enter item attributes and sizes along the two template 
axes.

4 Click Save.

5 To apply this template to style you were working on, click Apply Selected Template.

It is not required that you make entries on both axes of the template. If your 
merchandise is only consistent on one attribute, make entries on only one axis of the 
template. You can add attributes for the other axis, if needed, for each style in inventory. 

Editing, deleting, copying, or renaming style templates

To edit, delete, copy, or rename a style template:
1 From the Style window, click the magnifying glass to the right of the Select Style 

Template field.

The Select a Style Template window appears.

2 Select a template from the list and complete actions as needed:

 Edit—Use the same procedures to edit a template as for creating it. Additional 
choices for moving or deleting rows/columns and undoing edits are on the Edit 
menu under the displayed template.

 Delete—Choose Delete Selected Template from the Options menu. Deleting a 
template does not affect existing styles that were created with the deleted 
template.

 Copy—Select Copy Selected Template from the Options menu. Enter a name for 
the new template and edit as needed.

 Rename—Select Rename Selected Template from the Options menu. Renaming 
a template does not affect existing styles that were created with the template.
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Working with assembly items and groups (Pro)

Item assemblies and groups provide two ways to sell a predefined set of items by listing 
a single item on a sales document. However, the two item types vary in several ways, as 
outlined in the table below.

* Quantities of component items not pre-built into assemblies can be sold 
individually and built assemblies can be broken, freeing the component items for 
individual sale.

** Controlled with a preference setting.

*** Quantities and costs of group component items are tracked individually, not as 
a group.

Deciding between an assembly or group

Here are some key questions to ask when deciding whether to use an assembly or a 
group:

 Do you want to physically pre-build the set, thus removing the included items from 
inventory?

 Do you want the component items in the set to remain available for individual sale?

 Do you want the individual items printed on customer receipts or just the set as a 
single item?

 Do you sell more of the items individually or in the set?

Option Assembly Group

Pre-built? Yes* No

Sell component items individually? No Yes

Can include assembly item as component? Yes Yes

Can include group item as component? No No

Assembly/group item printed on receipt? Yes Yes

Assembly/group price printed on receipt? Yes Optional**

Component items printed on receipt? No Yes

Component item prices printed on receipt? No Optional**

Can define discount price? Yes Yes

Track costs and quantities? Yes No***
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Using Assembly items

An assembly item is an item that is itself composed of two or more inventory items and 
sold as a set. For example, a “Ski Slope Package” could be defined as an assembly item 
made up of a pair of skis, bindings, and boots, all of which already exist in inventory as 
individual items. Assembly items are often used to sell a set of items at a discount.

You “build” assembly items from existing items in inventory, referred to as the 
component items. An assembly item can be a component item of another assembly. 
When you build an assembly, the on-hand quantity of each component item is reduced 
by the quantity of the item included in the assembly and the on-hand quantity of the 
assembly item is increased by one. The number of assemblies you can build is dependent 
upon the on-hand quantity of the component items. Assemblies can also be broken, 
thus freeing the component items to be sold individually again.

Once an assembly is defined and built, it can be listed on receipts and sales 
orders/layaways in the same manner as regular inventory items. Sales reports include 
assembly items as unique items and do not report on the component items that are 
included in the assembly. Keep reporting needs in mind when assigning department, 
vendor, and descriptions to assembly items.

Adding and building assembly items

(Pro Multi-Store) Assembly items must be created at Headquarters, but remote stores can 
build or break assembly items to meet local sales demand. 

To add and build an assembly item:
1 Be sure all component items have been added to inventory individually, following 

the procedures earlier in this chapter.

2 With the Item list displayed, click New.

3 In the Item Type field, select Assembly.

4 Specify a Department name and, optionally, a vendor. 

If the items included in the assembly come from more than one department, you 
may consider setting up new department called Assemblies, or similar, to track and 
report the sale of assembly items.

5 Enter a descriptive name for the assembly in the Description 1 field (e.g., Holiday Ski 
Package). 

6 Enter information in other fields.

 You cannot enter an On-Hand Quantity or Average Unit Cost. Point of Sale 
calculates and auto-fills these fields when you build the assemblies. The average 
unit cost is calculated as the sum of the costs of the component items. This cost 
is recalculated each time you build additional assemblies.

 Optionally, enter a Regular Sales Price. If a price isn’t entered, Point of Sale 
auto-fills the field as the sum of the component item prices after they are added. 
You can edit the price later, if needed.
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 Specify a Reorder Point value if you want to be reminded on Build Point reports 
that more assemblies need to be built. (Refer to the User’s Guide for information 
about running a Build Point report.)

 Any other fields appropriate for the item. 

7 Click Edit/Add Items in Assembly. 

The Assembly components window is displayed. The previously entered 
information is shown in the top pane and the assembly item list is in the lower pane.

8 Add the desired assembly component items and quantities.

9 Click Build Assembly.

Point of Sale saves the information you have entered and the Build Assembly dialog 
displays, notifying you of the maximum number of assemblies allowed. This 
number is based on the on-hand quantities of the component items.

(Pro Multi-Store) You are prompted to specify the store for which you are building 
the assemblies before specifying the number to build.

10 Specify the number of assemblies you would like to build in the Quantity to Build 
field.
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11 Click Build.

The on-hand quantity of the assembly item is increased by the quantity you choose 
to build. The on-hand quantity of each component item is reduced by the total 
number included in the built assemblies.

The assembly component items are displayed on the item form for reference.

Breaking an assembly

Breaking an assembly reduces the on-hand quantity of the assembly item by one (for 
each assembly broken) and increases the on-hand quantity of each component item by 
the total number included in the broken assemblies. The individual components are 
then available for sale individually.

To break an Assembly item:
1 Highlight or display the assembly item.

2 Click Edit/Add Items in Assembly.

3 Click Break Assembly.

The Break Assembly window displays the number of existing assemblies that can be 
broken.

4 Specify the number of assemblies you would like to break in the Quantity to Break 
field.

5 Click Break.

If an assembly item includes a second assembly item as one of its components, breaking 
the first assembly does not break the second assembly item.

Note: Quantity and cost memos are automatically created to adjust inventory when 
building or breaking assembly items. The logged on user’s name is entered on 
the memo, along with appropriate comments (“Assembly created/broken from 
inventory”) and reason (“Creat/Brk Asm”). If users are not required to log in, 
you are prompted to enter a user name for the memo(s) upon creation.

Editing assembly items

Assembly item descriptive fields, price, vendor, etc. may be edited at any time using 
standard inventory editing procedures.

At times, it may become necessary to change the composition of an assembly due to 
stock outages, discontinued items, or other reasons. Existing assemblies must be broken 
before changes to the component items are allowed.
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To edit components in an assembly item:
1 Break all existing assemblies, as described earlier.

(Pro Multi-Store) You must break all existing assemblies for all stores before you can 
make changes to component items. Remote stores should discontinue selling this 
assembly item until you make changes and conduct a Store Exchange to update 
their inventories.

2 Add or delete component items. 

3 Click Save to record the changes.

4 Rebuild assemblies as needed.

Deleting an assembly item

Deleting an assembly item requires that you first break all existing built assemblies and 
remove the component items in the Assembly Components window.

To delete an assembly item:
1 Break all existing assemblies and remove all component items.

2 Click Save.

3 With the assembly item highlighted or displayed, click Delete on the window icon 
bar.

4 Confirm the deletion by clicking Delete. 

The item is deleted and cost/quantity memos are created to adjust inventory.

Using Group items (Pro)

A Group item provides an efficient method to list and sell two or more items, at a defined 
group price, by entering or scanning a single item identifier (UPC, Alternate Lookup, or 
Item Number) on a document.

An item group is not really an item at all, even though it is defined in inventory in the 
same manner as other items. Quantities and costs are not tracked for the group item; 
rather they are tracked for the individual component items contained in the group.

Group items differ from an assembly items in several important ways:

 Groups are not pre-built (i.e., the item quantities included in a group remain in 
inventory and can be sold individually).

 Quantities, costs, etc. are tracked for the individual component items, not for the 
group item.

 The individual items, and optionally the item prices, in the group are printed on a 
customer’s receipt.
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Adding a Group item

When a Group item is listed on a sales document, all included items are listed and the 
price of each item is proportionally discounted, as necessary, so that the total equals the 
group price defined in inventory. Individual item prices can be further edited on the 
receipt, if desired.

To add a group item:
1 Be sure all individual items to be in the group have been added to inventory 

individually.

2 From the Item list, click New Item.

3 In the Item Type field, select Group.

4 Specify a Department name.

If the items included in the group come from more than one department, you 
might want to set up a new department called Groups, or similar, to track and report 
the sale of group items.

5 Enter a descriptive name for the group in the Description 1 field.

6 Enter information in other fields:

 You cannot enter an On-Hand Quantity, Average Unit Cost, or a Reorder Point. 
These values are not tracked for a group item.

 Optionally, enter a Regular Sales Price. If a price isn’t entered, Point of Sale will 
auto-fill the field as the sum of the component item prices after they are added. 
You can edit the price later, if needed.

 Any other fields appropriate for the item. 

7 Click Edit/Add Items in Group from the Task List.

The Group components window is displayed. 

8 Use the Enter Item(s) field to add items to the group.
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9 Edit the Qty field, as necessary, for listed items.

This is the quantity of the item included in the group. By default, each item is listed 
with a quantity of one. 

10 Click Save.

Editing a Group item

To edit a Group item:
1 Locate the Group item in the item list and click Edit Item.

2 Make changes to the editable fields as needed on the item form.

3 Click Edit/Add Items in Group.

4 Add, delete, or edit the quantity of each included item.

5 Click Save.
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On your own exercises

On your own exercises are designed to provide you with an opportunity to practice 
some of the tasks and procedures covered in the lessons. Try the procedures here to help 
familiarize yourself with the software.

Before you begin, see “Working in Practice Mode” on page 43 for more information 
about the exercises and accessing Practice Mode.

Note: Be sure you are working on practice company data in Practice Mode when 
completing these exercises.

Scenario

In the previous lesson’s exercises, you learned that Joe, the manager of Al’s Sport Hut, 
has decided to start carrying duffel bags as part of his inventory. Now you must add the 
actual inventory items to QuickBooks POS. There are two sizes of duffel bags, large and 
small, to be added.

Follow the steps below to enter the items into inventory and complete some additional 
item tasks.

Add the new inventory item:
1 From the Inventory menu, select New Item.

2 Enter the following information:

 Item type - Inventory

 Department name - ACCESSORIES: DUFFEL BAGS

 Vendor name - SPORTSTORE, INC.

 Description 1 - Sport Duffel

 Attribute - Black

 Size - Large

 Regular sales price - $39.99

3 Click Save.

Joe also wants to add a custom field to the duffel bag item since there is a minimum 
order requirement from the vendor.

Add the custom field:
1 Locate the new duffel bag item you just selected.

2 Click Edit Item.

3 Click the Custom tab.

4 Click Define Fields.

5 Type “Minimum Order” in the Custom 1 Label field.
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6 Select the checkbox for Custom 1 to activate the new field.

7 Click OK.

8 Type 5 in the Minimum Order field.

9 Click Save.

Now add the small duffel bag to inventory by copying the large duffel bag item record 
and modifying the information.

Copy the inventory item:
1 Locate and highlight the large duffel bag item that you created previously.

2 Click Copy Item.

3 Change the following information:

 Description 1 - Sport Duffel

 Regular sales price - $24.99

 Size - Small

Since the small duffel is similar to the large duffel, POS asks you if you want to join 
the two items together in a style.

4 Select the “Join this item to the existing item(s) in a style” option.

5 Click OK.

Joe decides that he wants to add a new price level for all items at a 25% discount off the 
regular sales price. Since you’re already working in the item list, you’ll add the new price 
level from there.

Change the price level:
1 Locate and highlight the large duffel bag item.

2 Click Edit Item.

3 Click the Item Info tab.

4 Click Pricing in the Price & Cost section of the window.

5 Rename the Custom Price 4 field to “Owner.”

6 Change the markdown % for Owner to 25%.

7 Click Close.

8 Click Save.

The new “Owner” price level is now available for all items in inventory.
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Review questions
1 Which of the following documents affects inventory value or quantity in Point of 

Sale?

a Vouchers

b Sales receipts

c Adjustment Memos

d All of the above

2 In QuickBooks POS, a style is defined as a group of items that share what two things?

_____________________________________

3 A retailer carries small, medium, large, and extra large shirts in a variety of patterns. 
Every style they enter has the same sizes and attributes. How can they speed up data 
entry?

_____________________________________

4 True or False: You can have two items with the same values for their UPC entries.

_____________________________________

5 What effect on inventory does deleting a style have in QuickBooks POS?

_____________________________________

6 What does QuickBooks POS do if you delete an inventory item that still has a 
quantity on hand?

_____________________________________

7 For retailers who group their inventory into related items, what is the advantage of 
Style View?

_____________________________________

8 Identify the following:

_____________________________________
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9 Identify the following:

_____________________________________

10 True or False: Only Pro and Pro Multi-Store level users can define multiple vendors 
for an item.

_____________________________________

11 Because of a recent cost increase, an item's current price (Regular Sales Price) no 
longer delivers the desired department profit margin. What is one quick way to 
return the price to a level that delivers the intended profit margin?

_____________________________________

12 Which of the following are updated in inventory by a receiving voucher?

a quantity

b price

c reorder cost

d item cost

13 True or False: Before the component items in an assembly item can be edited, all 
existing built assemblies must be broken.

_____________________________________

14 True or False: You can edit the item number generated by QuickBooks POS.

_____________________________________

15 What is the maximum number of units that may be defined in QuickBooks POS if 
your client wants to track multiple units of measure?

a 2

b 3

c 4

d 7

16 Which QuickBooks POS feature allows your clients to quickly view the profitability 
performance of items at a glance?

_____________________________________

Answers to questions are located on the following page.



                                                                                                

161

L E S S O N  5

Answer key
1 D

2 Department

Description 1

3 Create a style template.

4 False. Each item must have a unique UPC entry.

5 It deletes the style and removes all items contained in the style from inventory. If 
necessary, it also creates cost/quantity memos to adjust inventory. 

6 It warns you, and if you proceed it creates quantity adjustment memos.

7 Working in Style View allows them to see both general information about the style 
and information about the members of the style in one window.

8 Style grid

9 Style template

10 True

11 Manually edit the Margin % field in inventory back to the original level. The price 
is recalculated by applying the margin to the new average cost.

12 A, C, D  

13 True

14 True

15 C

16 Ratings & Trends
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Notes

Use this section to keep a list of any questions you have as you’re working through the 
lesson. Keep this page nearby and ask the questions when you attend the live webinar 
sessions.
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